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1.1 Purpose of this document

This document gives instructions on how to use a custom family called Walking Paths.rfa in Autodesk
Revit 2012 to analyze the paths of inhabitants inside a building. The family can calculate the distances
travelled and time spent, giving objective criteria to evaluate the performance of a floor plan in terms
of work procedures. Different design options can be compared. Walkthroughs can be laid upon paths
to visualize in first person the spatial experience of a given worker or user.

1.2 Drawing the path

Start with a floor plan that has already a floor, rooms and doors.

L————  Waiting Room [
N EGG Dressing
!=

Load the Walking Path.rfa family at the Insert tab.

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Mar

000 D@y 26 5 &k
Kt |cap g};_l "lJ GE;} CAD e *
Link Link DWF  Decal Peint Manage Impert Impert  Insert Image Manage

Revit CAD Markup T Cloud  Links CAD gbXML from File Images
Link Import

Check the properties panel, where the family displays its default parameters. The customized
parameters of this family are under the Text section. It is advisable to change the Step and Path
parameters before starting drawing so you can later distinguish this flow from the others. One Path is
composed by many Steps and, sometimes, a Step has a Stop time to do a task in place. If it is just
walking, leave Stop time as 0. Change the parameters and click the Apply button.

Properties 1]

Walking_Paths .
01 Start

MNew Generic Model - Edit Type

Length 06096 -
Offset 0,0000
Work Plane Level: Level 2
Text £
Walking time 0166667 2
Stop time 1]
Step walk ﬂ —
Path EGG Patients
Dimensions ¥
Identity Data % 2 -

Properties help

To draw a path, just click at the beginning of the line and again at the end. If there is no floor, this
won't work. The lines are hosted on the floor, like doors are hosted on the walls.
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You can draw the path line by line, but you can also create a chain of them. This makes it easier if you
already know where to go. After you mark Chain in Place Component options, you can continue
drawing the path after the second click. To finish a path you can double click.

Medify | Place Component Placement Plane: Level : Level 2 A Chain
Properties =

L
‘Walking_Paths
01 Start ’

After you draw your first path, you get something like this:

,  Waiting Room [

Walk

walk @

waik .-&—

After it's drawn, you can go back and add more information to your steps. Select a step and add a
Stop time and a specific description in the Step parameter. The bubble at the beginning of the step will
grow according to Stop time parameter, helping you visualize where people spend more time.
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1.3 Improving visualization

Properties [=] . I

Walking_Paths .
01 Start

Generic Models (1) ~| Hg Edit Type

Length 4.1000 -

Offset 0.0000 o

‘Work Plane Level : Level 2
Text 2|2

Walking time 11120954

Stop time 40

Step scan

Path EGG Patient
Dimensions ¥
Identity Data A -
Properties help Apply

CMI_floor_plan.rvt - Project Browser [
0] Views (all) A

(= Floor Plans

. Ceiling

o Level 2

Level 2 - Workflow

i Ceiling Plans

m

After bubbles start to grow, you might want to change the colors of them, not to confuse with walls.

Thus, deselect the step by clicking in a blank part of the floor plan. The view properties will show up,
where you have to open Visibility/Graphics dialogue.

Properties (=

Floor Plan hd

Floor Plan: Level 2 - v] Edit Type

View Scale 1:100 -

Scale Value 1: (100 m

Display Model | Mormal |ﬂ

Detail Level Coarse

Parts Visibility : Show Original

Visibility/Grap... Edit,..

Graphic Displ... Edlit.

Underlay Mone

Underlay Orie... | Plan

Orientation Project Morth -
Properties help Apply

CMI_floor_plan.rt - Project Browser [&]
=0, Views (all) -
[] - Floor Plans

m

Go the Filters tab and add a filter. Add a new filter and add the rule to filter by Path and if it contains
one of the words that you entered in the Path parameter.

Visibility/Graphic Overrides for Floor Plan: Level 2 - Workflow Joiis i 2]
[ Model Categories | Annotation Categories | Analytical Model Categories | Imported Categories | Fiters |pes  Select one or more filters to insert,
—_— — I rojection/Surface I Vg s an
| ines [ Pattems [ Transparen..| Lin
Nurse flows
No fiiters have been applied to this view. Click Add to apply one. Patient flows
PET Nurse
PET Patient
Filter Rules
=
[ccmains V]
Patient
gy 5 oom R
Come 0 o [ o [ R — ==
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After you add a filter to select all the steps of a specific Path, you can change its appearance. In
Patterns, chose the Solid fill and a color. In lines, just chose a color. Add 60% of transparency if you
want a softer visualization for very complicated paths.

i Projection/Surface t
Name Visibility =
Lines | Patterns | Transparen... Lines
Fatient flows Override... |_ Override... Override... Override...
Fill Pattern Graphics [E3m)
Pattern Overrides
Visible
Color: [ rae ovo-255-054 ]
Pattern: Solid fill - E]
[ Clear Overrides ] [ OK ] [ Cancel ]
=

You should end up with something like this:

Projection/Surface

MName Visibility -
Lines Patterns | Transparen...
iPatient flows — L

Click OK and, from now on, all the paths you draw with the word Patients will get the green color.

L ,  Waiting Room

building

=
walk (B

1.4 Changing paths
If you want to change the points of your path and just drag and drop the end point, you will end up
with unconnected steps. You need to select the entire path in order to alter the points.

=  Waiting Room 5N —_——  Waiting Room [CN —————  Waiting Room (% =  Waiting Room [N

click again
extend to select the
selection entire path

drag and
drop points

click to
select
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The example below has two different kind of paths: patients (green) and nurses (blue). To avoid visual
cluttering of the many intersecting paths, the Thin Lines function was activated.

Bedruimty

Structure  Systemns  Insert  Annotate  Analyze  Massing & Site Collaborate  View

L N (R e (
mEeEEE B BEES
Visibility/ Filters Show Remove Cut Render Render El . Se
Graphics Hidden Lines Hidden Lines Profile in Cloud Gallery | View

Granhire n

1.5 Performance indicators

Filling the parameters for every step might be time consuming, but it is important to analyze
performance. The parameters can be visualized as a schedule, where each step fills a line. You can
check which room the path has passed through, how many meters of walking distance, and how much
time does it take (in minutes).

[= [ @ [ 22 | | [sw) Schedule: Walking Paths - CMIfloor_plan.rvt ==
I | - Walking Paths | -
— Path Step i Room: Mame ;| Stop time{ Walking time ;| Walking dista|
CT Hurse receive notifi Bedienil u:l 1 19
Roarm CT Nurse walk Kleedruimte : 0 2 6.9
CT Hurse walk Kleedruimte : 0 1 22 =
CT Nurse pickup patien Wachtruimte ;| 3 2 6.1
CT Nurse sCreening Wachtruimte ; 0 1 4.0
— 1 — CT Nurse escort Kleedruimte : 0 1 1.9
; CT Nurse apply fluid Kleedruimte : 0 1 28
CT Hurse escort Verkeeruimte: 0 0 1.5
CT Hurse escort CT-ruimte 0 Z 5.8
CT Hurse escort CT-ruimte 0 1 23
CT Nurse help scan CT-ruimte 1 1 23
CT Hurse walk CT-ruimte 0 1 47
CT Murse check quality Technischer | & i} 1.4
CT Hurse walk CT-ruimte 0 1 39
CT Hurse walk CT-ruimte 0 1 3.0
CT Hurse escort CT-ruimte 0 1 42
CT Hurse walk Verkeeruimte: 0 1 23
CT Hurse return base Bedienil uil 1 ]
9 16 599

To make a schedule like the one above, go to the View tab and find the Schedules drop down. Filter
by Architecture discipline, Multi-Category and give it a name, like “Walking Paths”. Pay attention to
the Phase selected, since if the paths are not in this phase, they will not show up in the schedule. You can
check in which phase your paths are by canceling this window, selecting a path, and looking at the
properties panel.
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Filter list:  Architecture v
fET] View [Manage WSy TGS P e
<Ml Category> +WalingPaths
@ Q /<@ @ m [2 Drafting View  [F Schedules =| [ Sheet - Areas (Gross Building)
\J =, . - Areas (Rentable) ® Schedue buiding components
30 Section Callout Plan _ Elevation Duplhcateliiew ﬁichedu%@antmes P Assemblies et
View ™ Views - Legends = Casework BT
B K :
Create L@ Graphical Column Schedule Fe Ceiings CHDAe
N - Cutain Pansls
= - Curtain Systems
= '
E..v_‘ Material Takeoff Cotain el Mdions Phase:
Doors Phase 1 -
Sheet List Blectrical Equipment
- Electrcal Faxtures L
- Floors 2
% Note Block
r—"
[ viewtist [ J[ e J[ e |
m m _

The next step is to add the parameters to the schedule. Look for the parameters that you have filled
previously: Path, Step and Stop time. Also add the calculated parameters Walking time and Walking
distance. In the available fields dropdown, change to Room and find the Room:Name parameter so
you can see which rooms a single path goes cross. Configure the other tabs as shown below. Make sure
that you mark Calculate totals at the Formatting tab for Stop time, Walking time and Walking
distance.

Fields |F\Ite( | Sorting/Grauping | Farmatting I Appearanoel Filter ‘So(ﬁng,lﬁrmpmg | Formatting I Appearancel
Available fields: Scheduled fields (in order): Fiter by: [Walldng distance v] [parametﬁr exists. 'l
A - Add —» Path
Assembly Code Step
Assembly Description El Stop time
Ballast Factor Comment. < Remove Walking time
Category Walking distance And: [} [(""“E} ']
Comments
Cost
Count
Data Datecode et
Description Add Parameter. .. e (none)
DRM {rec mnt dep) -

4 [ 3 Calculated Value. ..
Edit... Delete Delete And: {none)

Select available fields from:

iipe Cozgors n Fove Do

MuH:lEE Cateiunes
Space |

[ox [ cancel |[ rep | [oc ) cancal |[ nep |

— = —_—_—— e —
Fields | Fiter | Sorting/Grouping | Formatting | Appearance |

‘Fle{ds IFlIter ISomngIerpmgl Formatting |Appearar|oe‘

Sort by: [Paﬂw '] @ Ascending (©) Descending Fields:
Path .
[T]Header [7]Foater: [Tota\s anly '] [T 8lank ine Step Heading:
Room: MNama Walking distance
Then by: [(none) v] @ Ascending Descending Stop time
Walking time Heading orientatian:
. Walking distance eading orientation:
Header Footer: Blank line Horizontal ']
Then by (none) @ Ascending Descending Alignment:
Left -
Header Footer: Blank line [ = ]
_ Field formatting: Field Format...
Then by (none) @ Ascending Descending
Header Footer: Blank line
CE\ECUIE(:E totals
[T Grand totals:
[Z]1temize every instance

ok J[ come J[ b | oc ][ conel [[ e |

When you create a schedule, it will be opened maximized. If you want to see the schedule besides the
floor plan, you should Restore the window. This is handy if you want to make changes in the paths and
check the effects over the performance indicators. You can also double click in an element in the
schedule to highlight on the floor plan.

OPTIMIZING WALKING PATHS
| page 8| IN BUILDINGS

F.M.C. VAN AMSTEL




Properties | Walking Paths. | =@z -~
Path Step i Room: Mame ; Distance ; Stop time ; Walking time | A
Restore
E - CT Nurse receive notifi B u: 1.8 o 1
CT Hurse walk Kleedruimte ;5.9 0 2z
CT Nurse walk Kleedruimte 2.2 o 1
Schedule: Walking | Edit Type CT Hurse pickup patien  : Wachtruimte : 6.1 3 2
- CT Nurse SCTeening ‘Wachtruimte ; 4.0 0 1
Graphics £
e = CT Nurse escort Kleedruimte : 1.9 o 1
Visibility/Grap... [ Edit.. | 7 Hiurse apply fiuid Kieedruimie : 2 8 [} i
Identity Data A CT Nurse escort Verkesruimte! 1.5 0 0 =
View Template [ <Mone> CT iurse escort Clruime (58 [ ]
View Name Walking Paths CT Hurse escort CT-ruimte  § 2.3 0 1
Dependency Independent = CT Nurse help scan CT-ruimte 23 1 1
Phasing a CT Nurse walk CT-ruimte 47 o 1
Phase Filter Show All CT Nurse check guality Technischer ;| 1.4 5 1]
Bhase New Conetr... CT Nurzse walk CT-ru!mte 39 0 1
. CT Hurse walk CT-ruimte 3.0 0 1
Bl A | |cThurse sscort CT-ruimte 4.2 0 1
Fields Edit... E CT Nurse walk Verkeeruimte; 2.3 o 1
Filter Edit... E CT Nurse return base B uiZe 0 1 N
Sorting/Grou... [ Edit.. | 59.9 9 16
Formatting [ Edit..  E " |[CTPatient entrance 38 [i] 2
Eroperties help *FPI;' CT Patient walk ‘Wachtruimte ; 9.2 1] 3
CT Patient registration Wachtruimte § 2.1 3 1

1.6 Working with Design Options

With performance indicators from the schedule, you can compare different design options based on
objective data. Revit has a functionality to manage multiple design options for a single part of the
drawing. Click on Design Options button at the bottom of the screen.

PR ‘ =
Room Now Editing: Edit
Balie
[Option Set 1 Option 1 (primary) Edit Selected
= Oplion Set 1 Finish Editing
Option 1 (primary)
Option 2 Option Set
New (|
[N Rename
u.a Al A
/]I/ 4 | Accept Primary... I
==
Option
= New
] '
e Make Primary
E\ Main Model « [ Exclude Options
Rename

Add as many options as you wish. As soon as you click on Edit selected, the elements from other options
will turn gray and you won't be able to select them. If you want to move objects from the Main Model
to other options, you can select the elements and use the Add to set button.

———————  lialtlhg Room

E EGG Dresshg

0 B Main Model -
[ - ]

You can compare the performance of design options using schedules. Duplicate the schedule in the
project browser and configure it to show only the Option 1. You need to go to Visibility/Graphs Edit
button at the properties panel.
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. MRLruime _ DAOBETIES =
Formatting [ CEsy Verkeeruimte
B m Close Verkeeruimte
roperties help Bedienngsry @ Schedule ~
] Make Workset Editable | MRuimte
MIfloor_plan.ret - F
- Floor Plans Apply Template Properties... [T | schedule: Walking | +| ) Edit Type
[ Ceiling Create View Template From View... Wachtruinte | g hics POl
Level 2 ] B
e Duplicate View 5 Duplicate Wisibility/Grap... | |Edit... |
cotine Bl Convert to independent view Ik Dupficate; [EECISILES 5
=) Ceiling Flan ) ) | View Template <None»
- Ceiling Apply Dependent Views.. Duplicate [~ Nami [Walking st
f Level 2 Save te Project as Image... = Dependency  :Independent
£ 30 Views 4 -
&0 Delete Phasing e
Elevations ( Copy to Clipboard Phase Filter i Show All
- Walkthrougt Rename... Phase : New Constr.. -
| MRIPal  Select AllInstances ’ i #
Walkthr: Fields
[l Graphical Cg ¥ Properties Filter i
Legends Sorting/Grou...
Save to New File...
=& Schedules/Q Formatting Ed -
- Rooms Search... [ Aol
Walking Patis x Properties help Apply

For each option, you need to create a new schedule. You can display a summary of the paths by
unchecking the option ltemize every instance in Sorting/Grouping schedule properties. In that case,
you should also remove the parameters Step and Room:Name from your schedule in Fields tab. As you
can see from the example below, the second design option reduces nurse walking distance, but
increases it for patients.

Schedule: Walking Paths - De... EI@ Schedule: Walking Paths - De...EI@
Walking Paths - Design Option 1 | ‘Walking Paths - Design Option 2
Path | Stop time | Walking time | Walking dista Path | Stop time | Walking time | Walking dista|
CT Nurse ] 16 58.9 CT Hurse E] 17 627
CT Patient 29 19 89.7 T Patient 23 18 BED
EGG Patient 10 a 285 EGG Patient | 0 3 285
MR Nurse 12 2 79.2 MRl Nurse 12 14 495
IRl Patient 43 19 59.6 MR Patient 43 2 778
PET Nurse 14 41 1512 PET Nurse 14 41 1512
PET Patient a5 34 1249 PET Patient 85 4 12439

- e
acht
B
] L —
Trappenhuid Liftshacht
bocdanae
]:
e, §
CT-ruimie %
(=)
Beeldverwerking .
EL j_'ﬁ_/
Fantry| Technischeruimte . Technischeramte
R : ITE N
20 M@«
& 00 =) B Option 1 (primary) = & T2 |3 M omen? B

1.7 3D Visualization

You can also see your paths in a 3D view. Create a Default 3D View in View tab and change its
Visibility /Graphic options. You might want to uncheck displaying Ceilings and Doors, plus 40% of
transparency for Walls. In the Filters tab, follow the same procedure described at the previous section
Improving Visualization to color different paths.
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Model Categories Categories | Analytical Model Categories | Imported Categories | Filters | Design Options |
Show model categories in this view If a category is unchecked, it will not be visible.
Fiterlist:  Architectre
Projection/Surface Detail -
Visibility Halftone | [ evel
|5 ™ Areas O By View
Casework ] By View
7%?||ngs ] ByView ||F
E Jumns ] By View
| Wl Curtain Panels O | ByView
| W Cutain Systems ] By View
¥ Curtain Wall Mulions ] By View
i Detail ftems ] By View
] Doors O By View
| Wl Eecirical Equipment O | ByView
| - | Blectrical Fodures O By View
- | ¥ Entourage ] By View
View [ M Floos O | ByView
I Fumiturs d By View
@ Fumiure Systems O By View
|5 W Genenic Models O By View
3D Lighting Fotures O [Byview | .
View | — v .
yers
Al J[ mone ][ et ][ Ecandal | [l Cuttine s —
Default 30 View
Categories that are not overridden are drawn
according to Chject Stle settngs.
Camera
09 walkthrough o) (o) [ ) o)
=

You may change the visual style from Hidden Line to Consistent Colors for better visualizing spatial
dimensions.

& Graphic Display Options...

(5 Wireframe
{7 Hidden Line

1.8 Walkthroughs

Revit can render on the fly 3D walkthroughs to analyze spatial dimensions from a first person
perspective. This is useful to check if the layout can confuse people where to go in a path, if rooms are
big enough, if the order of them makes sense, and other possibilities. Communication with users is a
major application of this feature. To help users grasp spatial dimensions, it's recommended to insert a
human figure at the beginning of the walkthrough. You can download human families at

http: / /www.revitcity.com
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http://www.revitcity.com/

1. reception 2 waiting

| 5. scan 6. corridor 8. leave

For every path, you can create a walkthrough, but this is not automatically. You need to draw them

again, taking care of camera movements and other visual characteristics.

Open a 2D floor plan view. If you have many paths, it might be confusing to follow a specific one to
create the walkthrough, thus, before drawing the walkthrough, you can hide and isolate the path. Select
the whole path using the trick explained in Changing Paths section; activate Hide Element at the
bottom of the screen, then Reveal Hidden Elements.

2
o
B

M I—r@%t
5

so

Apply Hide/Tsolate to View

as)

Isolate Category
Hide Category
Isolate Element

H

Reset Temporary Hide/Isolate

= Reveal Hidden Elements
= Q[ F

Now you can create a Walkthrough at the View tab and Walkthrough.

View

g >

3D |cect
View

@ Default 30 View
Camera

!! Walkthrough

The screen highlights the selected path while still showing other elements, so you can avoid crossing
walls with your walkthrough. To revert back to the normal view, just go back to the same buttons that
activated this highlight.
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After you finished, you can test or adjust your walkthrough by clicking in Edit Walkthrough. Rewind to
the Previous Key Frame and Play.

& =] %

E‘:D Size Ef‘ht:,
& @ | Crop ||Walkthsough||

o e =)
[INEN "
Previous Previous Open Reset
Key Frame Frame Ikthrough| Cameras
| ‘Walkthrough

You can open the 3D view while editing the walkthrough. Just open the walkthrough and restore the
window, like you did with the schedules. If you close editing your walkthrough and wants to open it
again, double click at the edges of the walkthrough view and Edit Walkthrough at the top. The small
camera icon shows the first person point of view. You can drag it and move around.
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CML floor_plan.rvt - Project Browser (] 3D View: {3D} - CMI_floor_plan.rvt

=10, Views (all) -

=) Floor Plans

Ceiling

evel 2

evel 2 - Workflow
- Ceiling Plans

m

i Ceiling
G Level 2
= 30 Views

.30}

Elevations {Building Elevatio|
- Walkthroughs [ |
MRI Patient - Qption 1

i Walkthrough 1

‘. Walkthrough 2
- Graphical Column Schedule
Legends
=& Schedules/Quantities

Rooms

Walking Paths }
- Walking Paths - Design Opti
. Walking Paths - Design Opti )
Sheets (all)
=31 Families

1:100 EFx RGEBEY ¢ @

3D View: MRI Patient - Option 1 - CMI floor_plan.nvt

The standard height for the first person perspective might not be appropriate to give a good sense of
spatial dimensions. You can lower the whole walkthrough by switching to an elevation view.

\\
\ g
\.

1 Leuer 2
i “M G

If you want to see only one path in the walkthrough, add filters at the Visibility /Graphic properties.
Hiding doors is very important because Revit doesn’t open them. The user can get very confused after
crossing a closed door in a walkthrough. Avoid that by putting Doors 100% transparency at the Model
Categories tab.

| Model Categories | Annotation Categaries | Analytical Model Categaries | imported Categaries | Fiters | Design Options |

. Projection/Surface Cut
Name Visibility Halftone
Lines | Pattems | Transparen...| Lines Patterns
Fioree flows [ 0
MR Patiert 6% ]
! CT Patient [m] [m] Il

Finally, you can customize the visual aspects of your walkthrough at the Graphic Display Options. The
configuration below is rendered fast but still gives a good sense of spatial dimension, due to the
shading, ambient shadows and light. You can save this configuration as a View Template in order to
apply to future walkthroughs. In that way, you just need to configure the visual style once.
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Graphic Display Optio &u

= Model Display
Style: [Shaded V]
[ show Edges
Transparency: D 1]

Silhouettes: | <none>

_* Shadows
[] Cast Shadows

Show Ambient Shadows

_= Lighting

Scheme: |Exterior: Sun only

Sun Setting: [ <In-session, Lighting >
Artificial Lights: Artifigal Lights...
Sun: [} 0
Ambient Light: { 30
Shadows: [} 0

_+ Photographic Exposure

= Background

Background: [Skv -

Ground Color: _ RGB 165-165-165 ]

[ Save as View Template... ]

[ oK ] [ Cancel ] Apply

You can export the walkthrough as an animation if rendering on the fly takes too much time.

E Save [J] Famiy Types
[='7; Exports family types from the current
family to a text () file.
Save As v
GEL gbXML
| Saves the project a5 3 gbXMLfile,
Export »
B E Mass Model gbXML
{ ﬂ Saves the conceptual energy model as a
abXMLfile,
E; Publish »
IFC
Saves an IFC file.
Som
ODBC Database
Saves madel data to an ODBC
— |
database,
Licensing ~ »
EV“T Images and Animations N 1! Walkthrough
le] saves animations or image files
; - Solar Study
= [/ Image

[t et
|
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